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Productivity with Email 
We are getting bombarded with emails. Email Overload has become a real thing! 

The average worker gets about 620 emails/week and spends apparenty about 1.1 
mins/email. That’s around 11+ hours/week or about 28% of their time on email… 

What are the results of Email Overload? 

• Increases stress 

• Inability to focus on complex 

• Tendency to Multitask 

• May miss important emails 

• We are too reactive/not proactive 

• We live in our Inbox 

Email is a Great servant, but Poor Master!  

For many people, their Inbox is almost their de facto To Do List…. The problem is, using 
your Inbox as your To Do List is not a great idea. It forces you to become very reactive! You 
are bound to lose focus on other important Tasks.   

Or another way to look at it is that, by living in your Inbox, you inevitably end up 
responding to the latest email… In effect, your To Do List becomes someone elses To Do 
List. You are allowing others to “jump the ahead of others already in the queue. 

Checking Email 

How often should you check email? Maybe not as much as you do now…Naturally, it will 
vary for each person according to their role.  

What causes us to “overcheck emails”? Sometimes it is the little things. We have all 
become accustomed to just checking. Consider these causes: 

• FOMO – Constantly jumping in your Inbox...just in case an email has arrived.  

• Having an email screen always open.  

• Email notifications that constantly pull us back into our Inbox 

I want to suggest you should avoid “Over checking your Inbox” for several reasons: 

• It’s probably over-kill anyway.  

• It interrupts your flow & dilutes your focus 

• It causes you to Multitask 

We are probably overserving people with when we respond to most emails. Sure, we need 
to be responsive, but maybe not as responsive all the time. 
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Probably Overkill 

Think about emails you typically receive... How often do they require an instant response? 
Do they all have to be dealt with the moment they arrive? Well for some people, that may 
be the case, but certainly not for everyone! 

Depending upon your answer to this question, you may benefit from reassessing how 
often you jump into your Inbox.  

Indeed you may be guilty of over-checking for no good reason! 

Dilutes your Focus 

It’s all about focus! Every time you jump into your Inbox, there is a potential for you to 
lose focus on what you were working on. You end up trying to multitask…which is just not 
productive.  

Continuous Partial Attention 

In fact, you may not even multitask, but still your productivity will suffer. Let me introduce 
you to Continuous partial attention (CPA)  

It sounds like multitasking, though really multitasking is just one form of CPA. Where 
multitasking means trying to do two or more things at once, CPA means having part of our 
attention directed elsewhere even when we think we are focusing on just one task. 

Here is one common example; how many times have you found yourself writing an email 
while holding a conversation at the same time – only to find that you have been typing the 
words you were listening to rather than the message you were intending to send?  

The deleting and rewriting resulting from that….is a product of CPA. 

Causes you to Multitask 

Multitasking obviously means you are trying to do more than one job at a time. We know 
that for most people, this just does not work! We can easily fool ourselves to think we are 
just being more productive when in fact, everything we do takes almost twice as long as it 
should…AND…we make more mistakes as a result. 

Why is that emails cause us to lose focus or even multitask?  

Well our Inbox is so accessible for one thing but also, we are often alerted everytime an 
email hits our Inbox. If not by a sound, at least via the Desktop Email Alert. We see an 
email has arrived and we are tempted to check it. Most times people just automatically 
check it! 

Check email on your terms!  

This might be as often as every 30 minutes or every hour perhaps…. or as little as 4-6 times 
per day! Maybe set yourself a specific time each day to process your emails.  

Consider blocking out a recurring appointment time in your calendar if you think it is 
appropriate. 
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The point is, you should only really check emails when you have some time to deal with 
them.  If you are not able to spend some quality time looking at, and processing your 
emails, then why look at all?  

You are more likely just going to open, read and close emails without really processing 
them properly.  

Turn off your Email Alert – Stay Focused 

Consider turning off ALL email notifications. This is the most constant interruption or 
distraction you can have. It even interrupts you when you are typing in another program.  

It is so easy to lose your train of thought when you see or hear that an email has arrived in 
your Inbox. Removing this can help keep you focused on the task at hand. Consider 
checking your email when you want to, not when Outlook alerts you! 

The Desktop Alert allows you to see a newly arrived message preview that fades in then 
out again whilst you continue working. Sounds good in theory BUT…this little feature in 
Outlook causes us to lose focus and may even result in multitasking more than any other.  

To turn off ALL 
notifications - 
from your Inbox, 
select: File > 
Options> Mail - 
Then uncheck all 
the relevant 
boxes including 
the Desktop Alert. 
(See below)  

 

 

 

 

 

Email Alert by Exception 

You can create a rule to be alerted when an email arrives with certain conditions that you 
determine. Say, a Sender, or Subject Line or even Importance etc. 

Email Alert by Exception – Sender 

Step 1 

Select an email from your Inbox from the Sender (say your boss) or with a particular 
Subject name. 
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Step 2  

Then, from your Inbox – Choose Rules in the “Move” set of Icons as shown below. 

 

Then choose “Create Rule”. Notice how the email I have selected above is automatically 
selected. That is, Outlook assumes I wish to create a Rule from this type of email.  

 

Now simply choose your Alert Options as you see below. 
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Process your Emails – The 4Ds 

Do not let Emails fall off your Radar 

Once emails in your Inbox fill up your Screen and then go past the screen, 
you are in dangerous territory. 

It is far too easy to start missing important emails. You will need to start 
scrolling to find emails you may have missed. This happens very easily of 
course given the amount of emails we all constantly get. 

To avoid emails constantly falling off your radar, set yourself a target of not allowing 
emails to go below your computer screen. 

 

Handle Emails ONCE 

Are you guilty of double handling emails? You have a quick read and then leave them in 
your Inbox when you realise you are unable to respond right now? Perhaps you need 
more time to consider the contents…. Or you need to speak to someone first etc…. 

So, you mark the email Unread again as a reminder to yourself that you need to come 
back this email. Problem is of course, this email then is pushed further down your Inbox as 
more emails arrive! 

You end up having emails that require further action scattered throughout your Inbox. You 
now need to scroll up and down to find those emails.  This is incredibly inefficient when 
you think about it…. Not to mention unreliable!! 

Is there a better way?  I say YES there is. Every time you open an email, consider 
processing them using the using the 4D’s.  
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Introducing the Four’ Ds 

Use the 4D process as a way of ensuring you only handle an email once and that your 
Inbox only contains emails that you have not yet opened.  So, the 4D’s are: 

(1) Delete  

Quickly scan your Inbox and DELETE what you don’t need. Clear the clutter quickly. The 
email will sit in your Deleted items until you empty it. And remember to: 

a. Unsubscribe from emails if you no longer wish to see them 

b. Mark emails as Junk if it is Spam 

The idea is to permanently declutter your Inbox & avoid being distracted by emails that 
are unimportant and allow you to remain focused on important emails you receive. 

Unsubscribe Tip 

Type Unsubscribe into your Search Bar to show all the emails with an unsubscribe option. 

 

Delete the email with it open. 
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(2) Deposit  

Assuming there is no action you need to take, simply Deposit or File emails you wish to 
keep. Importantly, don’t leave opened Emails in your 
Inbox. 

a) Once you have read it, file it away for later 
reference in one of your Email Folders 

b) Consider creating some “Rules” to Deposit 
emails in an Email Folder automatically (See 
below) 

Email Rule to automatically move emails directly to a 
Folder 

You can set up an Email Rule to automatically move 
certain emails into you Folders. Very handy for your 
Newsletter emails. It helps eliminate clutter from your Inbox making it easier to focus on 
the important. 

Step 1 

Select an email in your Inbox that you wish to automatically move to a Folder in in future. 

In your Home ribbon, select the Rules dropdown then . Always Move Messages From:  

 

Step 2 

In the Rule & Alerts Dialog Box, select the Folder you 
wish to move these types of emails too. In the 
example below, I am choosing my Reading Only (next 
action folder) 

If you don’t have a Folder, you can create one at this 
point by slecting New and creating a new folder now. 
This will be automatically selected. 

Step 4 

Select OK… the Dialog box will now close and your 
rule is now created. The next time you get that type of email again, it will be 
auto0matically moved to your selected Folder. 

This is a great way of keeping your Inbox focused on important emails. 
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(3) Do Now  

Now scan your Inbox for what can be done quickly. If it can be done quickly or needs to be 
done quickly, then do it there and then. A quick Reply or Forward.  

If you are faced with a lot of unread emails…scan and triage first. Use the All or Unread 
Filters in your Inbox to quickly deal with those emails you have not yeat opened. 

 

 

Once you have replied, forwarded or completed the email, make sure you Deposit (File) 
the email as per previous step. 

Don’t leave the email you have responded to in your Inbox as a reminder that you are 
waiting for some information to come back to you. Use some of the 4th “D” tools I will 
show you now. 

 

(4) Do Later 

This is the most important step!  If you cannot do the required action on the email 
immediately, then, Determine your next action and Decide when you can do it. At this 
point you have several options.   

1. Move to an Email Folder (Next action folder) 

2. Move to an existing Meeting/Calendar Appointment 

3. Create a new Calendar Appointment or a Task from the email 

4. Apply a Category to the email 

5. Apply a Follow Up Flag to the email 

The idea here is that rather than continually searching your Inbox for emails that require 
action on your part, you use some of the smart features in Outlook to help you track the 
action you need to take. 

So, let’s look at each one of these 4 options in more detail.  
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Do Later (Option 1) - Move to an Email Folder 

You could set a up a few email folders that indicate the NEXT ACTION  you need to take 
and drag the email in the relevant folder.  

You might use Folders such as: 

1. Reading only 

2. For Follow Up 

3. Phone Messages 

4. For Action 

5. Delegate to EA 

6. File in Doc Mgt System (Trim, Objective etc)  

7. Monthly Report 

This type of system can work well…BUT you need to build regular times in your Calendar 
to come back your Next Action folders to action the emails in them. Otherwise, they could 
easily get forgotten. 

Create more Email Rules if you can to automate this 
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Do Later  (Option 2) – Insert email to existing Meeting or 
Appointment 

If the Email relates to an existing meeting or appointment you already have in your 
Calendar, then you can: 

1. Copy the email contents into that meeting/appointment. (Copy /Paste Text) OR 

2. Open the Meeting/Appointment and copy the email into it that meeting. 

3. Use the Insert Menu in the Calendar event to insert a copy of the email into that 
appointment. Insert > Outlook Item > Choose the email/emails > Insert as Text 
only or Attachment 

 

The idea is to not have to go searching for emails you need in your Meeting/Appointment. 

Additional Tip 

You can also create a new appointment alongside an 
existing meeting to insert your emails (or other 
attachments)  

This ensures no one else can see your attachments!  

This also works great on your Phone as 
well…especially of you use Outlook Mobile. 
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Do Later (Option 3) - Create a new Calendar Appointment 

To do this - Left Click and Hold the Email…then drag it to drop on your Calendar or Task 
Icon as shown below. 

This turns a “copy” of the email into a New Appointment/Meeting. 

The Text of the email is included in the new Task/Calendar item. 

Try Right-Click & Drag 

You can also try Right Mouse Clicking and dragging the email as shown below. This then 
gives you a few other options as shown opposite. 

It’s worth experimenting with what will work best for 
you. 
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Reply with Meeting - directly from an email 

Another option here is that you can also create a Meeting directly from an Email by 
clicking on “Meeting” in the “Respond” section of the Ribbon.  

You can do this with the email open or closed directly from your Inbox. 

With the Email Closed (Below) 
Select an Email in your Inbox and then choose ‘Meeting” in the Respond group of Icons in 
the Ribbon as 
shown here. 

 

 

 

 

 

 

With the Email Open 

Open the email you wish to 
Reply with Meeting. (See 
opposite) 

Select Meeting in the ribbon. 

This will create a Meeting or 
Appointment from the email. 
(see opposite)  

The “Required” field is automatically 
updated from the Reciever(s). You can 
now enter the remaining  meeting 
details.  

The formatting of the text,  links and 
images stays the same. 
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Do Later (Option 4) - Flag the email 

Finally, you can Flag the email with a date to come back to do later.  

Many people just Left Mouse Click on the Flag column in their Inbox to flag an email and 
then then scan their inbox for any Flagged item. These will turn red the next day. (meaning 
it is overdue) 

 

 

But this is quite an inefficient method of tracking your Email Flags and I think…I know, 
there is a much better way built into Outlook for you to use. 

Let us now look at a better way to use Email Flags to track important emails. 
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Using Email Flags - Reminders 

Flagging emails in Outlook is a simple and effective way to be reminded about an email 
that requires some action.  

In my experience, most people don’t use them as well as they could. They apply a flag to 
an email to try and remember to come back to it later…but then no system in place other 
than scrolling up/down their Inbox searching for flags they have applied. 

Here’s my suggestions to use Flags more effectively: 

1. Flag intentionally with a Date!  

2. Remove the email from your Inbox after you have Flagged it. 

3. “Mark Complete” or “Clear the Flag” when done. 

4. Track your flagged emails using the smarts of Outlook. 

There are several ways to apply a Flag on an email. 

Method 1 

With the email open, click on the “Follow Up” Flag menu to reveal the Flagging options. 

 

Method 2 

With the email selected in your Inbox, you can Right Mouse Click on the Flag. 

You can select to add a Flag 
by using one of the “Quick 
Flag” options. (Today, 
Tomorrow etc)… or you can 
open the “Custom” window 
to see further options as 
shown opposite. 

You can select a Start Date; a 
Due Date and even a 
Reminder time. Each 
date/time can be 
independent of each other. 
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Once you flag an email, a copy of the email also appears in your To Do Bar/To Do List and 
also in your Follow Up Folder. (In your Search Folders).  

You can Flag an email to take some action on a day and time, then remove the email from 
your Inbox and file it away.  (Remember the 4D’s).  

You will see your email in your To Do List or in your Follow Up Folder as the Flag Date 
approaches. 

Custom (Flag)Dialog Box 

When you open choose the “Custom” option, a Custom Dialog box appears and gives you 
numerous options. 

You can select a Start Date; a Due Date 
and even a Reminder time. Each 
date/time can be independent of each 
other. (See below) 

Flag to  

You can actually insert the action you 
need to take in this area.You can write 
yourself…or another person (EA’s take 
note), quite a detailed message to 
remind yourself of the Next Action you 
need to take. 

Start Date Reminder 

Personally, I ignore the Start Date. It will default to the date you opened the Custom Box. 

Due Date  

Always choose a Due Date. The best guess date by which you need to complete the action 
you need to on this email. 

Reminder Time 

I also recommend ignoring the Reminder Time. I think it is better to keep reminders for 
your Calendar Events.   

I will show you later how to get an Email Flag in your Calendar if the time is critical. IE…you 
need to call someone at a particular time. 

Mark your Flagged Emails Complete. 

Once you have completed the action you intended to take on the email, close the loop by 
marking the Flag Complete. 

Don’t leave the email in your Inbox at this point. I will show you several 
ways to track this email other than leaving it in your Inbox. 
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Flag emails you send to others 

You can also add “Reminder Flags” on emails you send.  

This is a powerful Follow Up system right at your fingertips within Outlook. 

 

Before you send your email, insert a Follow Up Flag as shown above.  

Remember to select the time etc as shown previously. Use the Custom option to reveal 
more date options.  

The email is stored in your “Sent Items” folder but is displayed in your To Do Bar for follow 
up on the date you choose.  

This is a fail-safe way to ensure 
nothing gets lost in the system!  

 

The Flag/Reminder is just for 
you…. 

You can add a Reminder Flag for 
the recipient. (See here) But be 
careful in using this. You are 
imposing your timelines and 
reminders on someone else which 
is not ideal.  

But this can really helfpful if all 
parties agree for this to be done! 

A better option is for the Sender to state when they require some action and for the onus 
is on the Reciever to place a Flag as their own reminder.  
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Tracking your Email Flags 

Once you’ve flagged the email, Outlook has several options you can use for automatically 
tracking it. Again, don’t leave the email in your Inbox. 

You can track your Flagged Emails from your To Do List/Tasks or by using a “Search 
Folder”.  

For this training, I’m going to show you how to use a Search Folder to track your Flagged 
Emails. 

Use a Search Folder 

You will notice that there is a group of Folders (usually under your Outbox) called; “Search 
Folders”. These are “Virtual Folders” in a sense. They don’t actually contain emails.  

Outlook can automatically Filter emails based on certain criteria. Large Mail, Unread Mail 
or Emails you have flagged etc. (see opposite).  

They can be customised to show ALL emails based upon the 
pre-defined conditions you set 

We are going to create “For Follow Up” search folder to 
track emails you have flagged. (See opposite) 

 

 

To create a New Search Folder called Follow Up if it is not 
already there.  

Right click on Search Folders > Select New Search Folder > 
Select “Mail Flagged for Follow Up” as shown here. 
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Once you have created your new Search Folder, you will notice that Outlook will retrieve 
all your Flagged Emails from every Folder….WARNING - there may be a lot of Red ones! 

      

But note below, the order with which these should be shown. “By Flag Due Date” 

If they are ordered by Date, then select the small Down Arrow 
beside Date as shown opposite. This will reveal the options you 
have to Filter this Search Folder. 

Choose to Filter by “Flag Due Date as shown here. 

 

 

Your Email Search Folder should then be sorted as below.  

Emails Flagged with “No Date” are shown first. 

Then those that are overdue are next. (These are shown in Red, because they are overdue. 

Then Today, Tomorrow, Next Week etc. 
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It may take some time to clean up this Folder, but thankfully you can highlight the very old 
ones and either: 

1. Clear the Flag or  

2. Mark Complete 

Simply use the Shift and Arrow keys to highlight all the emails you need to Mark Complete 
or Clear. 

Neither of these actions will delete the email, they just remove it from view in this “search 
Folder”. 

You can alsow “Rename” your Search Folder as you would do with any other Email Folder. 

And don’t forget to Add or Show this Folder In your Favourites as seen below. 

 

 

And that’s it. Thanks for purchasing this “On-Demand” training package. I hope you have 
found it helpful.  

 

Geoff Prior - Lingford Consulting 

 

 


